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LATEX zu benutzen ist das eine, dafür gibt es hervorragende Einführungen.
Was benötigen Sie für die Installation eines LATEX-Systems unter Windows? Was
mache ich mit MiKTEX, wozu brauche ich Ghostscript, was ist TeXmaker, und
warum schwören viele auf Emacs und vor allem wie paßt alles zusammen?

Diese Anleitung soll die Suche ersparen und zeigt Schritt für Schritt, was Sie
alles brauchen und wie Sie die einzelnen Komponenten einrichten.

Wenn Ihnen diese Anleitung hilft, ge-
fällt Ihnen bestimmt auch mein Buch
»Wissenschaftliche Arbeiten schrei-
ben mit LATEX«, in der 5., überar-
beiteten Auflage erschienen im mitp-
Verlag, ISBN 978-3-8266-9486-8.

Ich freue mich über Anregungen und Hinweise auf eventuelle Fehler. Bitte geben Sie bei
Rückmeldungen per Mail das Dokumentdatum mit an: 10. Dezember 2013

Danke an meine aufmerksamen Leser für viele Anmerkungen und Korrekturen.
Dieses korrekten Adressen für dieses Dokument sind:

• http://www.latexbuch.de/files/latexsystem-miktex.pdf für die PDF-Version und
• http://www.latexbuch.de/miktex-windows-7-installieren/ für die HTML-Seite.

Die englische Fassung ist verfügbar unter http://www.latexbuch.de/install-miktex-windows-7/
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1 LATEX einrichten kann jeder

LATEX ist ein Programm und eine Art der Dokumentbeschreibung. LATEX ermöglicht, wis-
senschaftliche Arbeiten zu verfassen ebenso wie hervorragende Briefe, Präsentationen und
vieles mehr.

Diejenigen, die bisher nicht mit freier Software gearbeitet haben, erscheint es anfangs
befremdlich, selbst verschiedene Komponenten zu einem System zu integrieren, so daß
sich manche nicht so einfach hintrauen. Deswegen stelle ich hier meine Umgebung vor,
mit der ich aus LATEX sowohl PostScript und PDF als auch HTML erzeuge.

Dies ist keine Einführung in LATEX. Zum Einstieg bis hin zum kompletten Ergebnis emp-
fehle ich mein Buch [17]. Lesenswert ist auch die De-TeX-FAQ[14], zu beziehen vom Dante-
Server 1, außerdem l2tabu, das veraltete Befehle und Pakete und ihre Alternativen aufzeigt.

Wer mit der Installation trotz der Anleitung nicht zurecht kommt oder eine sonstige
Frage zum Thema LATEX hat, der suche zunächst im Web und in der FAQ, bevor er gleich
mir persönlich schreibt. Ein deutschsprachiges Forum finden Sie auf http://www.golatex.
de.

Diese Anleitung ist anwendbar für Windows 7, Vista und XP. Sie ersetzt nicht die Original-
dokumentationen der einzelnen Programme und Bausteine2. Bei Die Anleitung bezieht
sich ausschließlich auf die hier angegebenen Programme. So sind z. B. die Abschnitte über
Emacs nicht ohne weiteres auf XEmacs übertragbar. Neuere Versionen der Programme
funktionieren in der Regel genauso (ohne Gewähr).

2 Was brauchen Sie überhaupt?

Um vernünftig arbeiten zu können, benötigen Sie neben der eigentlichen TEX Distribution
weitere Komponenten.

1Dante: Deutschsprachige Anwendervereinigung TeX e. V.
2wie ich schon vor Jahren im Forum de.comp.text.tex bemerkte
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2 Was brauchen Sie überhaupt?

LATEX Distribution: MiKTEX Die LATEX-Distribution ist der Kern des Systems. Sie beinhal-
tet die wichtigsten Programme, die zum Erzeugen von DVI, PostScript und PDF notwen-
dig sind, außerdem alle Zusatzpakete, die erweiterte Möglichkeiten wie z. B. Musiksatz,
Standardlayouts für verschiedene Organisationen, Layoutbesonderheiten, Schriften u. ä.
bieten.

Die Distribution ist nur dafür verantwortlich, aus dem Eingabetext das fertige Doku-
ment zu generieren. Im Editor schreiben Sie ihren Text. Ich verwende MiKTEX. Diese Dis-
tribution ist meines Erachtens nach sehr einfach zu installieren, funktioniert prächtig und
wird gut gepflegt.

Editor: Texmaker Damit der LATEX-Einstieg nicht zu schwer fällt, empfehle ich abwei-
chend von meiner Konfiguration Texmaker als Editor. Auf die Installation des ebenfalls
sehr beliebten TeXlipse, einem Plugin für Eclipse, gehe ich nicht ein. Jeder, der ohnehin
schon Eclipse nutzt, weiß, wie man Pakete nachinstalliert.

Texmaker ist für mausorientierte Benutzer ideal. Er bietet neben grafischen Menüs für
die meisten mathematischen Symbole und anderen wichtigen Befehle auch während des
Tippens von Befehlen mögliche Vervollständigungen als sogenannte »Tooltips«. Gerade
für den Neuling eignet sich Texmaker. Später können Sie dann auf Emacs umsteigen.

Natürlich läßt Texmaker einiges missen, das ich bei Emacs schätze, wie z. B. eine Nu-
merierung in der Gliederungsansicht oder eine leistungsfähige Behandlung von Marken
(Labels) und Literaturzitaten. Auch die integrierte Rechtschreibprüfung hat noch nicht die
Qualität, wie sie Aspell für Emacs bieten.

Editor: Emacs + RefTeX + AUCTeX + Aspell Wenn Sie gerade frisch mit LATEX anfangen
und von meinem LATEX-Buch hergeschickt wurden, dann überspringen Sie die Installation
von Emacs bitte.

Wer unter Unix bereits mit LATEX gearbeitet hat, benutzt eventuell Emacs, eines der mäch-
tigsten GNU Programme.

Ich habe mich wegen der Aufsätze AUCTeX und RefTeX für Emacs entschieden. AUCTeX
bietet für alle häufig benutzten Konstrukte aus LATEX Tastaturkürzel an, die das Arbeiten
erheblich beschleunigen. Zudem zeigt AUCTeX eine Voransicht von Grafiken, Tabellen und
Formeln direkt im Editor. Somit wird das Beste aus den beiden Welten WYSIWYG und Off-
linebearbeitung vereint[10]. RefTeX läßt Sie beim Einfügen von Querverweisen aus einer
Liste aller verfügbaren auswählen und hilft beim Erstellen der entsprechenden Marken.
Auch das Einfügen von Literaturzitaten geht mit RefTeX schnell und einfach.

Lesen Sie die Einführungen zu Emacs und AUCTeX und holen Sie sich die Emacs Refe-
renzkarte. Der anfängliche Lernaufwand lohnt sich und wird doch bald mehr als aufge-
wogen durch schnelles, effizientes Arbeiten.

Auch eine Rechtschreibprüfung namens Aspell haben Sie in Emacs.

Grafiken in PostScript mit Ghostscript PostScript ist in der Unix-Welt das Austausch-
format für Vektorgrafiken. So ist es auch unter LATEX am besten, Grafiken als (Encapsulated)
PostScript (PS/EPS) einzubinden.

Aus allen Windowsanwendungen mit ihren Dateiformaten wie z. B. existierende Word-
oder PowerPoint-Zeichnungen, Bitmaps oder Vektorformaten wie Visio läßt sich Post-
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3 Installation und Konfiguration

Script erzeugen, selbst wenn die jeweilige Anwendung dies nicht direkt unterstützt. Mög-
lich wird dies durch Drucken in eine Datei über einen PostScript Druckertreiber.

Um später vorliegende PostScriptdateien anzusehen und kleinere Veränderungen vor-
zunehmen, benötigen Sie Ghostscript mit seinem grafischen Frontend GSview.

HTML-Konvertierung: TeX4ht TeX4ht hat den Vorteil, daß es als Paket in der Distribu-
tion MiKTeX enthalten ist. Zur Benutzung siehe die Dokumentation in <texmf>/doc/html/
tex4ht. TeX4ht benötigt zur Grafikkonvertierung das Programm ImageMagick.

Übersicht und Lizenzierung Die angegebenen Paketgrößen beziehen sich auf das Dow-
nloadvolumen, nicht auf den für die Installation benötigten Platz.

Programm Größe MB

MikTeX Setup 90–1000 MB
Ghostscript for Windows (64-bit Download) 10 MB
GSview 3 MB

Texmaker 6 MB

GNU Emacs for Windows (Download) 45 MB
AUCTeX Windows Package (Download) 2 MB
GNU Aspell (Win32 version) 8 MB
LibPNG 1 MB
Emacs Konfigurationsdatei
Emacs TEX Registry Datei

TeX4ht 1,5 MB
ImageMagick Windows Binaries 10 MB

Σ ca. 1 · 103 MB

Alle in dieser Anleitung genannten Programme und Pakete sind mindestens kostenlos,
meist sogar freie Software3. Die Lizenzen sagen allesamt aus, daß die Verbreitung frei-
gestellt ist. Die meisten erlauben zudem die Veränderung des Quellcodes, einige wenige
verbieten wiederum den kommerziellen Verkauf.

Sie sind herzlich eingeladen, sich bei den einzelnen Projekten bei Gefallen auch finanziell
erkenntlich zu zeigen. Wie das geht, steht jeweils auf den Webseiten der Projekte.

3 Installation und Konfiguration

Mein System läuft auf Windows 7. Einige Zugriffspfade zu bestimmten Systemeinstellun-
gen können auf Ihrem System geringfügig von den beschriebenen abweichen. Zugriffspfa-
de bezeichnen Startmenüeinträge, Schaltflächen und Menüeinträge mit den entsprechen-
den Namen.

3Was bekanntlich ein Unterschied zu kostenlos ist: »Free as free speech, not free beer.« Siehe dazu die Seiten
der Free Software Foundation unter http://www.fsf.org.
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3 Installation und Konfiguration

Die Reihenfolge der einzelnen Schritte ist wegen Programmabhängigkeiten unbedingt
einzuhalten. Verwenden Sie ein anderes Verzeichnis für ein Programm, müssen Sie dies in
nachfolgenden Schritten berücksichtigen.

3.1 MiKTEX herunterladen und installieren

Laden Sie sich zunächst den 64-bit Net Installer von MikTeX Setup, welcher sofort alle Pakete
herunterlädt. Nehmen Sie nicht den Basic Installer, denn das Nachladen von Paketen ist gut
gemeint, verträgt sich jedoch nicht gut mit eingeschränkten Benutzerrechten.

Die Installation selbst ist sehr simpel: Einfach allen Vorgaben folgen und so lange auf
weiter klicken, bis Sie zum ersten Mal fertig sind. Wählen Sie bei Nachfrage eine »Down-
load Source« aus, die in Ihrem Land liegt. Da der Installer ungefähr 1 Gigabyte aus dem
Internet herunterlädt, führen Sie dies bitte nur an einem schnellen Internetzugang durch
und nicht über Mobilfunk.

Wenn der Download fertig ist, starten Sie den Installer erneut und wählen dann die
voreingestellte Option zum Installieren aus einem lokalen Verzeichnis.

Nach Installation können Sie alle Programme direkt von der Kommandozeile aufrufen.

3.2 Grafikerstellung und -konvertiertung

Den PostScript Druckertreiber richten Sie unter Windows ein mit der Maus: Start→ Geräte
und Drucker→ Drucker hinzufügen. Als erstes lokaler Drucker wählen und als Anschluß den
FILE-Port, der richtige Treiber ist der MS Publisher Color Printer (ab Windows 7, in der
Herstellerliste »Generic«), bzw. der Apple Color LaserWriter 12/600 (bis Windows Vista). Den
Druckernamen auf »PostScript File« setzen.

Nach der Installation navigieren Sie mit der Maus nach Start → Geräte und Drucker →
PostScript File → Drucker → Druckeinstellungen → Erweitert → Dokumentoptionen → Post-
Script-Optionen, um folgende Einstellungen vornehmen: Die Felder PostScript-Ausgabeopti-
on auf »Portabilität optimieren« und TrueType-Downloadoption auf »Umriss« setzen. Deak-
tivieren Sie das ICM Color Matching, um Farbverfälschungen zu vermeiden.

Ab sofort kann jede Windowsanwendung PostScriptdateien erzeugen, indem Sie den
neuen Drucker verwenden. Die erzeugte Datei – der Sie immer die Erweiterung .ps anstatt
des vorgegebenen .prn geben sollten – können Sie nun in GSview betrachten und nach EPS
wandeln.

Für die automatische Weiterverarbeitung installieren Sie Ghostscript for Windows (64-bit
Download). Beim Installieren gibt es nichts zu beachten (also »Weiter/Next« bis fertig). Da
Sie vielleicht auch PostScriptdateien zur Kontrolle ansehen möchten, laden Sie GSview 5.0
Win64 (Download), das grafische Frontend zu Ghostscript und rufen den Installer auf. Hier
können Sie bei der Installation das Verzeichnis ebenfalls auf C:\Programme\gs setzen, auch
als Programmgruppe wählen Sie die gleiche wie bei Ghostscript.

Es ist überaus sinnvoll (und für EMACS notwendig), Ghostscript dem Suchpfad hin-
zuzufügen. Also wiedereinmal in Start→ Systemsteuerung→ System und Sicherheit→ Sy-
stem Erweiterte Systemeinstellungen → Erweitert → Umgebungsvariablen der Variable PATH
das jeweilige Verzeichnis, z. B. C:\Programme\gs\gs9.07\bin, durch Semikolon abgetrennt
hinzufügen. Wichtig: Keine Leerzeichen vor und nach Einträgen in der PATH-Variable!
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3 Installation und Konfiguration

Um sich auf die Dauer die Arbeit zu erleichtern, empfehle ich, einen »EPS-Drucker«
einzurichten und zu verwenden, auch dafür habe ich eine kurze Anleitung im Internet
verfasst[16].

3.3 Texmaker einrichten

Den Installer von Texmaker müssen Sie als Administrator aufrufen. Wählen Sie mit einem
Rechtsklick im Downloadverzeichnis den Installer aus und klicken auf »Als Administrator
ausführen«.

Texmaker ist rasch installiert: Wie bei MiKTEX einfach alle Vorgaben des Installers akzep-
tieren.

3.4 Emacs einrichten

Wenn Sie gerade frisch mit LATEX anfangen und von meinem LATEX-Buch hergeschickt wur-
den, dann überspringen Sie die Installation von Emacs bitte. LATEX lernen reicht für den
Anfang.

Den kompletten Abschnitt über Emacs können Sie auch als Videotutorial ansehen.
Ein Mangel von Windows muß zunächst vor dem ersten Start behoben werden, nämlich

die Nichtexistenz der Umgebungsvariablen HOME. Umgebungsvariablen erlauben es, pro-
grammunabhängig bestimmte Verzeichnisse oder allgemein Zeichenketten festzulegen,
die dann von allen Programmen gelesen werden können. Dazu erstellen Sie in Start→ Ein-
stellungen→ Systemsteuerung→ System→ Erweitert→ Umgebungsvariablen. 4 einen neuen
Eintrag mit Namen HOME und weisen diesem ein beliebiges Verzeichnis zu, in dem Sie alle
individuellen Einstellungen speichern möchten. Der Name des Verzeichnisses sollte kein
Leerzeichen enthalten. Legen Sie dieses Verzeichnis bitte selbst an.

Für alle Umgebungsvariablen gilt: Möchten Sie die Umgebungsvariablen nur für den
aktuellen Benutzer anlegen, erstellen Sie sie in Benutzervariablen. Sollen sie für alle Benutzer
gelten, werden sie in Systemvariablen angelegt.

Sie benötigen GNU Emacs for Windows (Download) sowie AUCTeX Windows Package
(Download) als vorkompiliertes Paket. Entpacken Sie die Emacs-Archivdatei emacs-2x.
x-bin-i386.zip in das Programmverzeichnis aus (auch Winzip kann das), so daß Sie dann
ein Verzeichnis wie z. B. C:\Programme(x86)\emacs erhalten. In eben dieses Verzeichnis ent-
packen Sie auch das Archiv auctex-11.xx-e2x.x-msw.zip, wobei mindestens eine Datei
überschrieben wird. Die meisten Entpacker fragen vorher nach, und eventuell wird Win-
dows nach administrativen Rechten fragen.

Um Emacs bequemer aufrufen zu können, rufen Sie aus dem Unterverzeichnis bin das
Installationsprogramm addpm.exe auf und bestätigen dessen Nachfrage. Dies erzeugt eine
Verknüpfung im Windows-Startmenü.

Damit ist Emacs bereits installiert. Um die folgenden Konfigurationen leichter vorneh-
men zu können, dürfen Sie meine Emacs"=Konfigurationsdatei herunterladen. Benennen
Sie diese um in .emacs und verschieben sie in Ihr HOME-Verzeichnis.

4Geht übrigens schneller mittels des Tastaturkürzels Windowstaste+Unterbrechen.
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3 Installation und Konfiguration

Listing 1: Inhalt der Datei .emacs� �
(server-start)
(add-hook 'LaTeX-mode-hook 'turn-on-reftex)
(setq reftex-plug-into-AUCTeX t)
(setq-default ispell-program-name "aspell") �
 	
AUCTEX + RefTEX Falls Sie nicht meine .emacs Konfigurationsdatei verwenden möchten,
brauchen Sie die folgenden drei Absätze.

Die Integration von AUCTeX mit RefTeX muß noch separat aktiviert werden. Dazu star-
tet man Emacs und erzeugt in diesem die Konfigurationsdatei .emacs in seinem HOME-
Verzeichnis (UNIX-Kurzname ~) mit C-x C-f ~/.emacs RET (Das Kürzel C-x steht für die
Tastenkombination Strg-x, andere Buchstaben äquivalent. Übersetzt also: Strg-x, Strg-f,
»~/.emacs« eintippen, Eingabe drücken. Die Zeichen »~/« bedeuten, daß die Datei im
HOME-Verzeichnis abgelegt werden soll.). Dort fügen Sie folgende Zeilen hinzu:

(add-hook 'LaTeX-mode-hook 'turn-on-reftex)
(setq reftex-plug-into-AUCTeX t)

Achten Sie darauf, in dem Ausdruck tatsächlich das gerade, einfache Hochkomma zu neh-
men, nicht irgendwelche Akzente oder typografische einfache Anführungszeichen.

Dann die Datei speichern mit C-x C-s, Emacs beenden mit C-x C-c, und fertig ist die
Installation. Wenn nun beim Öffnen einer .tex Datei in der Menüleiste die Einträge »Pre-
view«, »LaTeX« und »Ref« erscheinen, hat die Installation geklappt.

Um die Voransichten schnell und platzsparend generieren zu können, ist die zusätz-
liche Grafikbibliothek LibPNG zu installieren. Dazu laden Sie die Archive »libpng« und
»zlib« von LibPNG herunter. Aus dem Binary-Archiv mit einem Dateinamen ähnlich
libpng_1.4.xx_win32.zip extrahieren Sie die zwei DLLs im Unterverzeichnis bin namens
libpng14-14.dll und plazieren diese in Ihr Verzeichnis C:\Programme(x86)\emacs\bin.
Genauso verfahren Sie auch mit dem Archiv zlib_1.2.xx_win32.zip und der darin im
Unterverzeichnis bin enthaltenen DLL zlib1.dll, auch diese muß in das bin-Verzeichnis
von Emacs.

Wenn Sie nun im PDF-Modus sind (C-c C-t C-p), können Sie nun Preview-LATEX mittels
C-c C-p C-d aufrufen.

Aspell Das Programm Aspell übernimmt die Rechtschreibprüfung in Emacs. Laden Sie
von GNU Aspell (Win32 version) sowohl das Programm (»Full Installer«) als auch das deut-
sche Wörterbuch (»aspell-de-0.50-2-3.exe«) herunter. Rufen Sie zuerst das Installationspro-
gramm können Sie alle Voreinstellungen getrost übernehmen.

Wie vorher schon müssen Sie das Programm selbst zum Suchpfad hinzufügen. Also
wieder einmal in Start → Systemsteuerung → System und Sicherheit → System Erweiterte
Systemeinstellungen → Erweitert → Umgebungsvariablen der Variable PATH das jeweilige
Verzeichnis, z. B. C:\ProgramFiles(x86)\Aspell\bin\; durch Semikolon abgetrennt hin-
zufügen.
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3 Installation und Konfiguration

Zu Ihrer .emacs-Konfigurationsdatei fügen Sie nun folgende Zeile hinzu, um Emacs klar
zu machen, dass er für die Rechtschreibprüfung Aspell nutzen soll:

(setq-default ispell-program-name "aspell")

3.5 Dateitypen einrichten

Zur weiteren Vereinfachung erstellen Sie einen neuen Dateityp. Dazu fügen Sie zunächst
der Konfigurationsdatei .emacs am Anfang folgende Zeilen hinzu:

(server-start)

Dann laden Sie meine Emacs-TEX-Registry-Datei herunter und editieren diese – also
nicht einfach doppelklicken, sondern Rechtsklick und Bearbeiten. Ersetzen Sie falls nötig
in Zeile 6 mit @= beide Vorkommen des Verzeichnisnamens C:\\Programme(x86)\\emacs
durch den Namen des Verzeichnisses, in dem Sie Emacs installiert haben. Achten Sie dar-
auf, dass die tatsächlich immer zwei umgekehrte Schrägstriche \\ als Pfadtrenner verwen-
den. Speichern Sie die Datei und rufen sie dann per Doppelklick auf. Windows wird Sie
fragen, ob die Informationen der Registry hinzugefügt werden sollen. Bestätigen Sie dies.

Listing 2: Inhalt der Datei texfile.reg� �
Windows Registry Editor Version 5.00
[HKEY_CURRENT_USER\Software\Classes\texfile]
[HKEY_CURRENT_USER\Software\Classes\texfile\Shell]
[HKEY_CURRENT_USER\Software\Classes\texfile\Shell\Open]
[HKEY_CURRENT_USER\Software\Classes\texfile\Shell\Open\Command]
@="C:\\Program Files (x86)\\emacs-23.3\\bin\\emacsclientw.exe -n -a \"C:\\Program C

Files (x86)\\emacs-23.3\\bin\\runemacs.exe\" %1 %*"
[HKEY_CURRENT_USER\Software\Classes\.tex]
@="texfile"
[HKEY_CURRENT_USER\Software\Classes\.bib]
@="texfile"
[HKEY_CURRENT_USER\Software\Classes\.lco]
@="texfile"
[HKEY_CURRENT_USER\Software\Classes\.sty]
@="texfile"
[HKEY_CURRENT_USER\Software\Classes\.cls]
@="texfile" �
 	

Sie können dieses Prozedere für weitere Dateitypen durchführen, wie etwa .bib, .sty,
.cls und .lco. Ab dann führt ein Doppelklick auf eine .tex-Datei zum Aufruf von Emacs,
weitere Dateien werden im selben Programmfenster geöffnet. Damit ist Emacs komplett
installiert.

Sie haben nun ein System für das Erzeugen von druckfertigen Dokumenten im PDF oder
PostScriptformat. Möchten Sie kein HTML erzeugen, dann sind Sie an dieser Stelle fertig.
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4 Und nun? Benutzung

3.6 Korrektur, wenn Sie Administrator sind

Nun starten Sie Emacs, am besten über das Startmenü. Wenn Ihr Windows-Benutzerkonto
Administratorrechte hat, dann bekommen Sie eine Fehlermeldung über ein Rechteproblem
des Verzeichnisses .emacs.d/server/.

error: The directory `~/.emacs.d/server' is unsafe

Dieses beheben Sie, indem Sie die Besitzereinstellungen ändern: Schließen Sie Emacs.
Klicken Sie auf Start und tragen in das Suchfeld cmd ein. Dies öffnet eine Kommandozeile.
Wechseln Sie in das Emacs-Verzeichnis unterhalb von HOME mittels

cd %HOME%\.emacs.d

Dort rufen Sie folgenden Befehl auf:

takeown /f server

Dieses brauchen Sie nur zu tun, wenn Sie Administratorrechte haben, und auch nur
dann funktioniert der Befehl überhaupt.

3.7 TeX4ht und ImageMagick installieren

TeX4ht ist bei MiKTeX dabei, und wenn Sie die vollständige Installation wählen, auch be-
reits fertig zum Benutzen auf der Platte. Voraussetzung für TeX4ht ist zum einen Ghost-
script, das bereits im vorigen Abschnitt installiert wurde, sowie ImageMagick, das Sie wie
folgt einrichten:

Laden Sie die ImageMagick Windows Binaries von der ImageMagick-Website herunter und
installieren diese. Am einfachsten alles bestätigen, was voreingestellt ist, dann wird das
Konvertierungsprogramm automatisch in den Suchpfad eingetragen.

Wollen Sie den LibreOffice-Export von TeX4ht nutzen, muß ein Zip-Packer im System
verfügbar sein. Ich verwende dafür Info-Zip, wobei ich nur die Datei zip.exe in ein Ver-
zeichnis kopiere, welches ohnehin bereits im Suchpfad enthalten ist. Wird bei der ersten
Benutzung von oolatex.bat festgestellt, daß die erzeugte LibreOffice-Datei fehlerhaft ist,
kann dies in der Regel behoben werden, indem abermals die Datei C:\Programme(x86)
\MiKTeX2.9\texmf\tex4ht\base\win32\tex4ht.env editiert wird und die Marken <oo-C
alt> und </oo-alt> durch <oo> bzw. </oo> ersetzt werden und umgekehrt, womit eine
alternative Bearbeitung aktiviert wird.

4 Und nun? Benutzung

Herzlichen Glückwunsch! Auch TeX4ht ist nun installiert und das TEX-System kann alle
wichtigen Ausgaben erzeugen. Wenn Ihnen diese Anleitung geholfen hat, dann lesen
Sie auch mein Buch »Wissenschaftliche Arbeiten schreiben mit LATEX«.

Wie sieht es mit einem Export nach Word aus? Es gibt im Prinzip keinen Grund, LATEX
nach Word zu exportieren, trotzdem existieren Programme, die LATEX nach Rich Text For-
mat (.rtf) konvertieren, welches sich dann problemlos in Word öffnen läßt. Als besten Weg
empfinde ich jedoch den Weg über HTML oder LibreOffice. Heißt: LATEX mittels TeX4ht
nach HTML oder LibreOffice konvertieren, und dies dann in Word bzw. LibreOffice öff-
nen.
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4 Und nun? Benutzung

Viele Ausgaben können Sie im Editor anstoßen, dafür gibt es entsprechende Knöpfe un-
d/oder Tastaturkommandos. Für die Benutzung der Emacs-Zusätze sei auf deren Doku-
mentationen verwiesen. Mag der Einstieg auch hart erscheinen, es lohnt sich wirklich.

Benutzung von TeX4ht TeX4ht ist ein flexibles Werkzeug, wenn es darum geht, LATEX
nach HTML zu konvertieren, jedoch verliert man bei den vielen Optionen anfangs leicht
den Überblick. Mit ein wenig Übung läßt sich jedoch auch hier alles erreichen, was man
sich vorstellt.

Die TeX4ht-Dokumentation an sich ist nicht besonders üppig. Eine komplette Auflistung
der Optionen, ausgegeben in die Logdatei, erhalten Sie, wenn Sie einen Aufruf

htlatex.bat myfile.tex "html,2,info"

in der Kommandozeile auf einer beliebigen LATEX-Datei absetzen. Unbedingt htlatex.bat
aufrufen, nicht einfach htlatex, da sonst ein MiKTeX-Programm gestartet wird.

Da ich so klares XHTML und so kleine Dateien wie möglich erhalten möchte, verwende
ich den meist den Aufruf

htlatex.bat myfile.tex "xhtml,2,fn-in,NoFonts,fonts,graphics-,sections+,C
next"

für die Umwandlung. Das erzeugt XHTML, eigene Dateien für zwei Gliederungsebenen,
keine speziellen Schriftenanweisungen, aber prinzipielle Formatierungen, nichtskalierte
Grafiken und hilfreiche Hyperlinks. Wer eine originalgetreuere Wiedergabe der Schriften
haben möchte, läßt die Option NoFonts weg, was natürlich zu ein wenig größeren Dateien
führt. Für eine monolithische Datei wird statt der 2 eine 0 angegeben.

Grafikumwandlung Benutzen Sie für Zeichnungen vektororientierte Programmen wie
CorelDraw, LibreOffice Draw, Visio oder ähnliche. Generell rate ich davon ab, Diagram-
me oder Grafiken als Bitmap zu erstellen, etwa mit Photoshop, GIMP und Konsorten. Fast
alle Anwendungen wie Excel oder PowerPoint verarbeiten ihre Grafiken ebenfalls vekto-
rorientiert, und erzeugen deshalb mit Hilfe des PostScript Druckertreibers hervorragende
PostScriptdateien. Diese PostScriptdateien wandeln Sie dann in EPS um [16]. MATLAB
kann direkt PS/EPS erzeugen.

Die generierte Datei mit der Erweiterung .eps laden Sie in GSview, um zu sehen, ob die
Bounding Box noch angepaßt werden muß. Um in GSview die Bounding Box anzeigen zu
lassen, wählen Sie Menü Options→ Show Bounding Box.

Sollte die Bounding Box nicht stimmen, so können Sie mit dem Befehl File→ PS to EPS
entweder automatisch oder manuell die Bounding Box festlegen und die Ausgabe in eine
neue Datei speichern. Automatisch können Sie dabei wählen, wenn die komplette Grafik
verwendet werden soll. Manuell legen Sie die Bounding Box nur dann fest, wenn uner-
wünschte Kopf- oder Fußzeilen abgeschnitten werden sollen.

Unbedingt beachten: Erstellen Sie PostScript oder DVI, müssen Bilder im (Encapsulated)
PostScript-Format (EPS) vorliegen, wohingegen beim Verwenden von pdfLATEX hingegen
nur Grafiken verarbeitet werden, die in PDF, JPEG oder PNG vorliegen. Zwar können
Sie sowohl dem einen als auch dem anderen LATEX-Prozessor alle Bildtypen beibringen,
müssen dazu aber spezielle Optionen verwenden, die dann vielleicht nicht portierbar auf
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5 Wenn etwas nicht funktioniert

andere Systeme sind. Soll also beides – DVI und PDF – erzeugt werden, müssen die Bilder
meist auch in zwei Formaten vorliegen.

Wollen Sie mittels pdfLATEX aus Ihren Dokumenten das PDF erzeugen, so müssen die EPS-
Dateien also nach PDF umgewandelt werden. Dazu gibt es den Befehl epstopdf, der etwa
so aussieht:

epstopdf file1.eps

Bitmapdateien wie JPEG oder PNG werden von pdfLATEX direkt gelesen. Nur für den
normalen LATEX-Aufruf müssen sie mit bmeps nach EPS umgewandelt werden .

5 Wenn etwas nicht funktioniert

Sollte irgendetwas nicht funktionieren, oder sich offensichtlich seltsam verhalten, liegt das
häufig an vergessenen Umgebungsvariablen. So sollten Sie zunächst überprüfen, ob al-
le von dieser Anleitung geforderten Umgebungsvariablen entsprechend gesetzt wurden.
Fehlt eine, oder ihr Inhalt ist falsch, dann ist es möglich, daß eine danach durchgeführ-
te Installation – vor allem von Preview-LATEX – fehlschlägt. Also nochmal. Außerdem eine
beliebte Fehlerquelle sind Dateien am falschen Ort. Einfach nochmal nach Anleitung kon-
trollieren.

Werfen Sie gegebenenfalls einen Blick in die Installationsanweisung des jeweiligen Pa-
kets. Denn natürlich kann auch meine Anleitung Fehler enthalten. Wenn eigentlich alles
stimmen müßte, am besten unter Angabe der Versionsnummer bei mir nachfragen. Viel-
leicht habe ich eine Annahme getroffen, die nicht allgemeingültig ist, oder eine neue Ver-
sion eines Pakets arbeitet anders.

6 Ausblick

Bei all den Möglichkeiten, die einem die Vielzahl der Pakete für LATEX bieten, gilt im-
mer: Einfache Layouts und Strukturen wählen, insbesondere, wenn das Dokument auch in
HTML publiziert werden soll. Mit Hilfe dieses Artikels jedoch sollte es jedem einigerma-
ßen mit Windows vertrauten Benutzer möglich sein, relativ rasch mit dem Schreiben und
Setzen von Texten beginnen zu können.

Wenn dieses Dokument dazu beiträgt, die Scheu vor der Einrichtung und Nutzung eines
solchen Systems ein wenig zu lindern und somit die Hemmschwelle zum Einstieg in LATEX
herabzusetzen vermag, dann hat es seinen Zweck erfüllt.
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